
 

ersion 1.6.5      Bloomsday 16 June 1998 — Gorgonzola sandwich anyone?

Hello and welcome to the slightly better organised manual, formed by taking the old ReadMe 
and banging at it with a piece of two-by-four. Complaints, clarifications, bugs, omissions, 
rephrasings of my deathless — if only for sheer turgidity — and tenebrous prose all welcome at 
turly@geocities.com. 

See also the webpage at http://bounce.to/turly (a bit easier to remember than all that 
wretched geocities gobbledegook, even if you do have to look at an advertisement for five 
seconds…)

Unfortunately, my spare time is at a premium as I’m trying to find somewhere to live and dealing
with banks/solicitors/estate agents, etc., has me coming out in a rash. (A minor update — I thought I’d 
found somewhere reasonable, put a deposit on it but never signed anything, paid large amounds of dosh for legal 
fees, valuation fees and structural survey, etc., and have now been told that the vendor doesn't want to sell it after all.
10 weeks wasted and now I have to start all over again, dammit.    25-May-98 Update: Argh! Dammit! — It’s 
happened again!    Different house, same old crud — and on the very day we were due to exchange contracts!    Look
for a news item on your TV screens soon involving a deranged programmer, a 100 gallon vat of custard, a bicycle 
pump, and the entire population of Cork estate agents :-/    Meanwhile, the search continues…

What is it?

FinderPop 1.6.5 extends the Mac OS 8 Finder’s contextual menus. Features 
include: user-selectable contextual menu font/size/icon size, automagic CM popup 
by clicking and holding without having to press the control key, and a number of 
optional submenus — including Processes, contents of selected folder, Finder 
windows, FinderPop, and Desktop. Additionally, it enhances navigation via the 
Standard File dialogs.

Features
Just thought I’d list the major features of FinderPop here, as this manual has become very badly 
organised (“badly disorganised”?)…

• Control-free CMM popup — just click and hold — now works in many more 
apps; apple data detectors become even handier! You can now (1.5.9) turn this on or off on a per-
application basis; FinderPop adds an item to the “Help” menu for all apps except the Finder.
• Command-click (or click and hold) a folder to get a popup of its contents (or 
command-control-click for an immediate contents popup.) [1.6.1] You can now grab, get 
info, trash or show an item from a contents popup.



• Selectable Font/Size for FinderPop submenus
• Process, Contents, Windows, FinderPop and Desktop submenus
• Move, Copy, Alias or Open items selected in Finder to any item in the FinderPop 
hierarchy (see Power User Topics chapter)
• Control-clicking or clicking and holding in any unused menubar area pops up 
CMM in any app
• Grab and drag — “grab” an item in a FinderPop menu by pressing ‘G’ while it’s 
selected, then drag it around to do with as you will…
• Standard File enhancement — click and hold on a folder in Standard File to see 
(and select from) its contents!
• You can now select items from the FinderPop menus (e.g., by control-clicking an 
unused portion of the menubar) while the Standard File dialogs are up — whatever
you select will be “opened.”

What’s New?

FinderPop 1.6.5 (Bloomsday 16 June) 
• Fix Prefs saving problem for turning control-free popup on or off via the item in the 
Help Menu (it wouldn’t be saved to disk unless the FinderPop control panel was opened
before shutdown.) As we say in the trade, “Duhhhh.”

• Optionally allow clicking-and-holding on a folder or disk in the Finder to popup a 
Contents menu rather than a contextual menu — this behaviour is more in line with 
what PopupFolder users expect.    Apparently. Control-clicking a folder will bring up the 
normal contextual menu in all cases.

• Be a bit smarter about generic icon sizing — if the font is big enough (read: 12 point or
greater), use 16*16 generic icons instead of the much more limited 16*12 mini icons (of 
which there are far fewer in the System file.)

• Optimise things a bit more.

• WorldScript II and FinderPop: Peter Hartmann sends his latest findings (see the “Bugs
and Features” chapter) which more-or-less exonerates FinderPop. Yay! Which, 
unfortunately, doesn’t do much for his unhappy situation.    Boo!

FinderPop 1.6.4 (Tues 9 June) Fix problem reported by Stephen Giles involving opening files 
within ResEdit using FinderPop’s contents popup menu during the file open dialog. ResEdit 
would insist the file was damaged beyond repair (it lies — the file was perfect, and opening it 
“normally” worked without problems.) Additionally, control-command-clicking a folder inside a 
file open dialog’s file list should now have the same effect as command- clicking — this is 
specially to please all six people on the planet who have four-button mice.

FinderPop 1.6.3 (Mon 8 June) Be smarter about the help balloon (command- option) file info 



stuff — still not 100%, but improved quite a bit. Moving the mouse outside the selected menu 
item while FinderPop is generating the folder submenu for that item will now abort the submenu 
generation. Option-clicking a process from the process menu now hides the current process 
before switching to the selected process; New Logo graphics courtesy of Carlos, merci bien. 
Slightly more snazzy and shameless Aboutbox. Command-clicking somewhere in a standard file 
dialog box’s file list now works regardless of the setting of the “Auto CMM Popup delay.” A few
other minor fixes.    Have just spent a marathon 7 hour Macsbug session ’til 3:30AM chasing one
heisenbug, and still haven’t squished it. Moan. Grumble. Gripe. I’m off to get some sleep…

FinderPop 1.6.2 (Fri 15 May) Fix bug whereby quitting the Finder causes nasty things to happen 
the next time a contextual menu is invoked.
Fix bug in standard file stuff where, under certain circumstances, no folders would show up in 
the file list.    Be a bit smarter about switching to the Finder — cuts down unnecessary switches 
to Finder immediately followed by switches to something else; speeds things up a bit...
In addition to displaying the “Get Info” cursor when holding down command and option over a 
menu item, FinderPop will now also display a little help balloon giving some basic information 
about the file under the mouse (alpha stage, may not work correctly all the time!)

Some other news:
WorldScript II — after some stout detective work by Peter Hartmann, this extension causes 
FinderPop to behave badly if you press “G” to “Grab and Drag” an item from a FinderPop menu.
I’m looking into it.

Apple Data Detectors and non-US keyboard layouts news: According to Timo Orre: “I just want 
to add that if you use Contextual Menu Enabler extension version 1.0.2 (the previous version), it 
works fine for non-US keyboard layouts (but without the possibility to turn it off in applications).
Unfortunately I dont know a publicly-accessible download site for it.”

FinderPop 1.6.1 (Sun 10 May) Add option to not colourise an item’s text if it has a label (any 
icon will always be label-coloured.) You’ll never guess to which already horrendously 
overcrowded dialog I had to add yet another checkbox. Sigh. Pretty soon you'll need a 1024*768 
screen to view it.
Also fix embarrassing bug whereby both the “Popup near…” items stopped working. 
Additionally, you can now “Grab”, get info, show or move to trash any item selected from a 
“pure” Contents popup — i.e., a popup got by command- control- clicking a folder.

May-01-98: The last version’s “contest” has been won by Lawrence Guzzetta, who identified 
Thomas “Prozac” Hardy as the author of the poem from which the phrase “Ah no, the years, the 
years…” comes, and provided “see, the white storm birds wing across.” as the next line (actually,
Hardy has some pretty natty, if depressing, lines in that poem — “Ah no, the years, o; / Down 
their carved names the raindrop ploughs.”)    These lines have stuck with me since I last read the 
poem (at school in 1983!) Perhaps Hardy’s the Leonard Cohen of the ’90s — the 1890s. 
Anyhow, enough of my witterings and on to the prizegiving ceremony proper: If ever FinderPop 
goes explicitly “Pintware” again, Lawrence, feel quite free to check that little “I got turly a pint” 
checkbox…!



FinderPop 1.6.0 (Weds 29 April — my birthday!) fixes some bugs (and hopefully doesn’t 
introduce any.)    Sorry it took so long to get this one out — been up the walls with “real” work, 
I’m afraid, and had two weekend stag parties to attend (yee—haaa!)

Rewrite icon gathering/drawing code. We now support label colours and no longer interfere with 
an app’s own menu icons. FinderPop now works as you’d expect with apps other than the Finder 
that expose file aliases (such as DragThing 2.5.)    Still some work needing to be done to the icon 
stuff — including speed increases.

Choosing the “Largest Block” item from the Process menu now shows the “About this 
Computer” Finder window.

••Things to note: QuicKeys’ “Pop up Menu” extension is incompatible with FinderPop.    I’m 
looking into it.    Also, Jan Skarbek alerts me to the fact that Apple Data Detectors 1.0.2 won’t 
work properly unless you’re using a US keyboard layout.

This version’s competition is (as it will be from now on): name the poet and complete the 
quotation at the top of this page (following the date.) The use of Internet Search Engines is not 
allowed. The first person to email me with the correct answer wins a free copy of FinderPop! :-) 

FinderPop 1.5.9 (Tuesday 17 Mar — the St. Patrick’s Day “Paddy MacHackery” special) allows 
you to selectively toggle control-free popups on a per-application basis.

It works by adding a menu item to the Help menu, much as Apple Data Detectors does; this 
means that Jigsaw Puzzle* and a few other apps (hopefully including Escape Velocity) become 
usable again when “control-free popups in all apps” is enabled.

Bit of a rewrite of the low-level patches to be more stable in the presence of QuicKeys, etc. 
Hopefully I haven’t broken anything in the process...

Better popup menu positioning algorithms.    Decouple “Empty Trash” item from the Desktop 
submenu code. Better Prefs File format — hopefully this will be future proof… (famous last words).

FinderPop 1.5.8 (Thursday 26 Feb) fixes a problem with the Menuette control panel (among 
other things.)

[Saturday night, 4:15 AM] A Paddy MacHackery special: you can now click-and-hold on an 
existing selection in most applications without the dreaded “oh no! my selection has become 
deselected” just before the contextual menu pops up…

You can now Command-Control-click a folder in the Finder for an immediate contents popup. In
Standard File dialogs, command-clicking a folder in the list will bring an immediate contents 
popup.

Note new Apple Data Detectors address: 
http://applescript.apple.com/data_detectors/



FinderPop 1.5.7 (Friday 13 Feb —wooo!    tempting fate or what?) should be a tiny bit quicker 
and a good bit more robust.    Also, you can now command-click and hold a folder in the Finder 
to get a popup of its contents. Revampled° one or two sections of the manual (the website 
address may be changing soon...)

Still haven’t had the spare time to implement the new “tabbed” user interface, I’m afraid...

FinderPop 1.5.6 (30 Jan) does a better job of enhancing the standard file dialogs — click and 
hold on a folder in a file Open… or Save… dialog and be presented with a popup menu 
displaying the folder’s contents; select a file from it and, voila, it’s opened!

The Standard File “Contents” popup menus should now work as expected in all cases (thanks to 
John Gotow for a handy hint — I owes ya a pint, John :-).

The “Contents” submenu, which normally only appears if you have selected a folder in the 
Finder, can now be made to appear if you just click in a Finder window (without selecting 
anything.)    This can be handy if you just want to “view by name” quickly in order to locate 
something. 

You can now have an optional “Put Away” menu item, for when you’ve selected something in 
the Finder whose “home” directory isn’t where it currently is. This also works for disks and 
network volumes — just like selecting “Put Away” from the File Menu.    I was amazed at the 
number of people who asked for this — lads, in all fairness, have yez considered pressing 
Command-Y?    But it was easy to add, so I did :-).

Finally, I made a number of other improvements — hopefully I haven’t broken anything in the 
process.    The “More Settings” user interface — to which you’ll have recourse if you want to use
any of the new features here — is getting worse; I’ll have to redesign the entire control panel 
when the “More Settings” dialog starts getting too big for a 640*400 monitor (which should be 
about March/April at the current rate of progress.)

FinderPop 1.5.5 (8 Jan) was the initial attempt at enhancing the standard file Open/Close dialogs.

FinderPop 1.5.4 (2 Jan) was only released as an alpha (well, actually, two alphas) with some very
hairy bugs.

FinderPop 1.5.3 (8 Dec) should fix the “Empty Trash” bug introduced in the last version. Sorry 
about that…

If you’re one of the kind people who’ve localised FinderPop and want to do this version, the only
thing that’s changed from 1.5.1 is the addition of the “Empty Trash” string in the STRs resource.

FinderPop 1.5.2 (24 Nov) is the latest entrant in my attempt to keep the great volunteer crew of 
localisers busy — nothing’s changed on the UI front, lads! :-)
It fixes a number of minor bugs, adds an “Empty Trash” feature (only if you have the “Desktop” 
submenu enabled.) “Grabbing” should now work all the time instead of intermittently as it did 



previously.
Oh yeah, a number of people didn’t know that you can cancel any drag-and-drop operation by 
“dropping” the item being dragged into the menubar, so I thought it might be worth mentioning.
Additionally, it’s probably a good idea to highlight the fact that you need Apple’s Internet 
Address Detector stuff (available at
http://applescript.apple.com/data_detectors/) to get FinderPop working in 
non CMM-aware apps. Note that IAD is incompatible with some apps such as Quark XPress 
which use Control-Clicking — John Moe, moejo@post.uwstout.edu, has written a freebie
control panel, IADD, which lets you turn off IAD for selected apps. It’s available at 
http://www.luminet.net/~dmoe/iadd.sit.hqx
Thank you Mr. Moe.

Matthieu Baudoux, matthieub@skynet.be, has kindly set up *FinderPop Announce*, a 
read-only mailing list to which you might like to subscribe in order to receive information about 
the availability of new versions of FinderPop.

To subscribe, send a mail to <requests@lists.qwentes.be> with the following message
in the body of your mail :
subscribe finderpop

To unsubscribe, send a mail to <requests@lists.qwentes.be> with the following 
message in the body of your mail :
unsubscribe finderpop

FinderPop 1.5.1 should improve stability, and fixes a couple of bugs. 

FinderPop 1.5 final (5 Nov) is the same as 1.5f11 with just a name change. I will post this to 
InfoMac, and will contact the people who volunteered to localise FinderPop to ask them to 
localise this version.
Hey, by the way, did you know that there have been — count ’em — 18 versions of FinderPop in
the last 13 weeks?    Now I’m heading back to Cork and a social life, this rate will be somewhat 
reduced… :-)

FinderPop 1.5f11 hopefully fixes a problem with St. Clair Software’s nifty-looking Sleeper 
control panel (and probably a few other apps also.)

Went to an interesting Halloween party in Oakland…    Quite entertaining; everyone there 
seemed to be enjoying themselves; some of the music was quite good, too!    Didn’t think much 
of yer man Josh Wink, though ;-)

FinderPop 1.5f10 fixes a couple of embarrassing bugs (eg, you were not able to switch off the 
“clicking in unused menubar area” feature) Implements new algorithm to check whether a piece 
of menubar real estate is, in fact, “unused.”    Sports a new, snazzy-looking icon courtesy of Will 
Cosgrove.



Unless people report major showstopping bugs, this will become 1.5 FINAL next week.    (Or 
unless I go mad over the weekend and start implementing new stuff...)

Oh yeah, one other thing, would the person who posted 1.5f7 to InfoMac using my name and 
email address please desist?    I know you meant well, but I was hoping to give ’em 1.5 Final 
instead of all these half-baked version numbers.    If you do think it’s worthwhile to post an 
interim version, please do so with your name, not mine!    Thank you.

FinderPop 1.5f9 has a completely rewritten low-level trap patching mechanism in an attempt to 
get it working in apps other than the Finder. This works relatively well for non-CMM-aware apps
if used in conjunction with Apple’s Internet Data Detectors (available at
http://applescript.apple.com/data_detectors/). Grabbing seems to work a 
bit more reliably (and in colour!)    One minor tweak to the font stuff might make things even 
better for OS8/J users. You can now control-click (or click and hold) in the unused portion of the 
menubar and have the Contextual Menu drop down. Lots of other minor tweaks, etc. If there are 
no showstopping bugs (hah!), I’ll release this version as 1.5 Final next week (and would-be 
localisers can contact me then.) 

As usual, you’ll have to pay a visit to the ever more crowded “More Settings” dialog to enable 
some of these features.

Just back from a weekend in San Diego. One cool city, and I don't mean that in the thermal sense
— the weather was superb; the thermometer didn’t say so, but the sun seemed to be far hotter 
there than it is up here in Cupertino.    Even ran into a FinderPop user in a pub (Hi Tim, and 
thanks for the pints!) Small world.

FinderPop 1.5f8 should fix the odd font behaviour seen by Japanese users, plus a couple of other 
bugs. It also adds a first stab at “Grabbing” — press the ‘G’ key when you have something 
selected in a FinderPop submenu, and you can pick it up and drag it around the Finder, to do with
what you will.

My apologies for the user interface, which is again becoming more cluttered.    I will redesign 
this sometime after I get back to Cork in mid-November.

A “Marketing Slogans” chapter has been added. I’ve made the “What’s New” section blue to 
make it stand out.

On a brighter note, it may interest regular readers of the FinderPop saga that I finally found a 
place that sells Beamish Stout on draught in San Francisco!    My first pint of Beamish since 
August 4!    <f/x: lip-smacking sounds> And it wasn’t bad, either — better than their Guinness, 
anyway, although I suspect my tastebuds were in tatters by that stage.    I think the place was 
called “Lucky 13” or something (possibly at Market and Church?)    In any event, I recommend 
that any fine beer connoisseurs amongst you give this stout a try.    One caveat: an ideal pint of 
Beamish (would be 20 fluid ounces, but that's another matter :-) should have a creamy “collar” 
less than 1 inch high, and not a three-inch job like they gave me. Or tried to — once they heard 
my accent I think they realised I wasn’t some gullible non-stout drinker...



FinderPop 1.5f7 hopefully fixes the odd behaviour seen by some unfortunates in the “Desktop” 
submenu.

FinderPop 1.5f6 fixes the embarassing ‘every alias is italicised’ bug; sorry about that.    As we say
in the trade, “Duhh.”

FinderPop 1.5f5 should fix the menu font/size problems that some people were experiencing. I 
tried about five different ways before finally remembering the way the old comms toolbox 
MDEF did it.    Duhhh. It also finally implements the Desktop submenu. 
I’ll have to redesign the user interface some more, but I thought I’d get the bugs fixed first.

FinderPop 1.5f4 was released only to a couple of people who’d experienced bugs — basically 
testing a couple of bugfixes.

FinderPop 1.5f3 is now freeware! This version should fix the annoying “couldn’t load code 
fragment” startup errors which some people were getting. It also adds a first stab at some extra 
features; these will be expanded over the coming weeks. 

FinderPop 1.5f2 is no longer “PintWare”, I have contacted those who have registered so I can 
return their registrations. It is now freeware again!    Because I’m currently working for Apple, 
this is probably the best way to avoid any perceived conflict of interest. Although this will 
probably change! In fact, it has, but not so’s anyone would notice — see the last page of this 
manual for details.

FinderPop 1.5f1 fixes a couple of cosmetic mini-icon bugs, and allows application launching to 
occur from the main menu even if there is no Process menu (thanks, Stephen Giles.)
 
FinderPop 1.5f0 has a revamped and simplified user interface, and allows you to display the 
FinderPop Items embedded directly inside the Finder’s contextual popup menu as opposed to 
inside a “FinderPop” submenu. 1.5f0 also supports generic icons and selectable menu fonts and 
sizes, and has a number of other bugfixes.    

      Oh yeah, it’s also “PintWare” — it’s still free, but if you’d like the opportunity to express 
your gratitude and get me a couple of pints, you can do so by registering it via Kagi for $7 (the 
price of two US pints of Murphy’s in Fibbar Magee’s — hey, why are US pints a wimpy 16 fluid 
ounces? :-).    You are under no obligation to register it; this is strictly for the people who wanted 
to send me “something cool”, but got put off by the postage costs, hassle, etc.

      There is no functional difference between PintWare-registered and “normal” FinderPops. 
Other than the glowing feeling in the depths of your soul if you got me a pint, that is.

See the FinderPop AboutBox or the last page of this manual for details.

What’s Coming?



Christmas, and the goose is getting fat. (A free copy of FinderPop to the first person who emails 
me with the next line to that piece of doggerel. Apr-01-98: This “contest” has been won by Phil 
Hudson, who emailed all the way from sunny Botswana, correctly replying “Please put a penny 
in the old man's hat.”    If ever FinderPop goes “Pintware” again, Phil, feel quite free to check 
that little “I bought turly a pint” checkbox…!)

More and more features.    I now have a feature “wish list” the length of my arm (but still 
welcome other submissions.)    Certain features of the late and apparently much lamented 
PopupFolder are well represented in this list.    Some of the more obvious features which should 
eventually appear:

• Grab-and-drag — “grabbing” an item from within a FinderPop submenu will “pick it up”; 
you’ll then be able to drag the icon around as if you’d picked it up in the Finder.    Hopefully — 
this is still being worked out.

• Advanced FinderPop Settings — a new dialog which will allow you to fine-tune various 
aspects of FinderPop operation.

• Memory — if you opened a document with a certain application last time, and control-click a 
document of the same type again, FinderPop will remember this and automagically add the 
application to the main CMM menu, and have the mouse positioned over the relevant item in the 
menu, so all you need do is release the mouse button.

• Disable inappropriate applications — if you have a Finder icon selected, inappropriate apps 
will be disabled or removed from the FinderPop submenu.    (E.g., SimpleText isn’t really 
appropriate for Word documents, so why present you with the choice?)

• Ability for FinderPop to operate in applications other than the Finder.
This could build on Apple’s new Internet Address Detector stuff…

• Embedded Application Menus — i.e., have the Finder menus appear in the CMM popup menu. 
A minor convenience, but one that a number of people have asked for.

• Background Menu Caching — FinderPop submenus will be capable of being built in the 
background during idle time.

• More options for menu organisation (along the lines of Fabien Octave’s cool BeHierarchic, 
which I had never seen until today — thanks, AA.)

Feel quite free to contact me with feature requests (see the last chapter, “Contact Info”), but 
please don’t expect miracles. There’s only one of me — admittedly quite a bit more of me now 
after thirteen weeks of American-sized meals, and no soccer matches three times a week…
______
* What amazes me is that someone actually used Jigsaw Puzzle and noticed the bug.
° Whaddya mean “Revampled” isn’t a word? :-)    "Revamped" + "Trampled" = "Revampled". So there.


